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Overview of Workshops

•First workshop:  Logic Models and Measurement

•Second workshop:  Effective Client Surveys

•Today:  How to Use Excel to Analyze 
Survey Data



Today

• Introductions

• Some brief Excel basics

•Creating an Excel spreadsheet and doing data entry

• Inspecting and cleaning your data

•Organizing your data for analysis

•Analyzing your data – basic descriptive statistics



Not Covered Today

•How to analyze qualitative data

 Open-response interview questions

 Data from interviews or focus groups

• Interpretation -- how to know what the findings mean

•Visual presentation of findings

 Charts, graphs, infographics



Today’s workshop:  

Presentation + Practice

•Demo and explanation

•Practice on your laptop



Columns:  A, B, C, 
etc. 

Rows:  1, 2, 3, etc. 

Cell address:  
Column letter and row 
number

• Shown in address 
window 

Formula bar: 
Information typed in 
cells will also display 
here.

Excel Basics



• Format columns for 
each type of data.

• Add borders and font 
formatting for ease of 
viewing data.



Excel File

• Save your Excel file in a secure location
• Give it a clearly-stated file name

Excel Worksheets

• Each Excel file can have multiple worksheets
• Right-click on the tab to name the worksheet



Prepare a spreadsheet for data

•Columns – each survey question

•Rows – data from each survey



During the time you have been in this 
program:  

Always
Most of 
the time

A few 
times

Never

1. Did THRIVE provide a welcoming environment?    

2. Did staff explain things in a way you could 
understand?

   

3. When you needed to contact a staff member, were 
you able to reach her/him within 1 – 2 days? 

   

4. Did staff respect your ethnic and cultural 
background?   

   

Example – satisfaction survey

Today’s Date ____________

Program Site  
 Broadway
 Silverbell







Identifiers

• If you know the identity of each respondent

Unique identifier code for each respondent

• If it’s an anonymous survey (respondents not known)

Unique survey number for each survey

Write a number on each paper survey, and include a 
matching column for this in the database. 

If you need to find the paper survey again you can do 
this with the survey number. 

Plan for Data Entry



• What type of data do you want to have for each 
question?  Some typical kinds of data:

 Numeric

 Date

 Text

• It depends on your analysis plan for each question. 
Be consistent!

• How to treat missing or wrongly-marked data

Plan for Data Entry

How will you enter the answers for each question?



During the time you have been in this 
program:  

Always
Most of 
the time

A few 
times

Never

1. Did THRIVE provide a welcoming environment?    

2. Did staff explain things in a way you could 
understand?

   

3. When you needed to contact a staff member, were 
you able to reach her/him within 1 – 2 days? 

   

4. Did staff respect your ethnic and cultural 
background?   

   

Example – satisfaction survey

Today’s Date ____________

Program Site  
 Broadway
 Silverbell





Consistency in data entry

Data Validation



12. What is your age?  _____

13. What is your gender?      
 Female     
Male     
 Transgender    
 Other _______________

14. What is your race?      
 American Indian/Alaska Native
 Asian     
 Black/African American    
 Native Hawaiian/Pacific Islander
White/Caucasian
 Other or multi-racial _______________ 

15. What is your ethnicity?
 Hispanic
 Non Hispanic



12. What is your age?
 Under age 18
 18 - 24
 25 - 55
 56 - 64
 65 - 75
 Age 76 or over

Typical Kinds of 

Program Data

• Numeric
• Date
• Text

Which kind of data is this?
How would you analyze it?





Planning for Analysis

Text (also known as Nominal Data)

Numbers

Percentages

Numeric Data

Sum

Average

Median

Range

Math – add, subtract, multiply, divide

“Frequencies”



Planning for Analysis

Dates

Can be used as numeric data (to some extent)
• Subtract an End Date from a Start Date = Duration

• Subtract Date of Birth from Today’s Date = Age Today

• Add 30 to Exit Date = Date of one-month follow-up



8. Which services have you used at the Community 
Resource Center? (check all that apply)

 Case management

 Rent assistance

 Utility assistance

 Resume assistance

 Child care

 Financial education

Plan for Data Entry – “Check all that apply”



• Case management
• Rent assistance
• Utility assistance
• Resume assistance
• Child care
• Financial education

8.  Which services have you used at the Community 
Resource Center? (check all that apply)



10.  Please tell us one important thing that you 
learned in the financial education class.  

Open Response Data

You might have a question like this



Type the respondent’s exact words in the column for this 

question. Resize columns and rows as needed, and wrap text to 

view the answer. 

Open Response Data



Before Analysis:  Inspect Your Data

Missing data

Inconsistencies

Out of range values

If possible, find the correct response and revise



• Resize columns and rows

• Apply borders to cells

• Make column headers stand out

• Freeze header row for scrolling

 On the Ribbon, select View

 Click the dropdown on Freeze Panes, and select 
Freeze Top Row.

First

Make your data easy to view

Practice doing this 



You can inspect and change data on the copy, and you 
can go back to the original if necessary. 

1. Right click on worksheet tab, and select Move or 
Copy.

2. Check the box for Make a Copy

3. Select a location for the copy, and click OK. 

4. Rename both worksheets – right-click on worksheet 
tab, select Rename, type the name, hit Enter. 

Next

Make a copy of your original worksheet

Practice



In some types of data, unwanted duplicate records 
could be there.  To check for duplicates.

1. Highlight the relevant column (Name or ID number).

2. On the Home tab, select Conditional Formatting, 
and select Highlight Cell Rules. 

3. From the list, select Duplicate Values. Choose a 
color, and click OK.

4. Scroll down the column to view any duplicates. 

Do you need to check for duplicates?



Apply a filter

1. Select the entire header row.

2. On the Home tab, on the far right of the 
ribbon, click on A-Z Sort and Filter. From the 
dropdown, select     Filter.

3. Now you will have little dropdown arrows on 
the header name of each column. 

A quick way to check for missing or 

out of range values

Practice



4. Select the dropdown 
arrow on one of your 
columns and view the list.

5. Does the dropdown list 
include the word, 
“blanks”?

6. Is there anything shown 
on the list that shouldn’t 
be there?  

Using a filter



To find the problem 

records:

1. Uncheck “Select All”

2. Select the item that you want to 
correct, and click OK.

3. Excel will display only the 
record(s) with the value that you 
selected. 

4. Make corrections, if known.

5. To remove the filter, check 
“Select All” or unselect the filter.  

Using a filter



Organize data onto separate worksheets

This is useful if you want to analyze subsets of respondents.

• Highlight the header row and on the Home tab, select     Filter.

• Select the field that you want to filter, for example, Gender. 

• When you have filtered for a particular gender, you can highlight 
the filtered data, then copy and paste it to another worksheet. 

• Name the new worksheet so you remember what it is.

• Go back to the first worksheet and remove the filter. All the data 
will be there.   

Another way to use a filter



Analysis



It helps to have an analysis plan

• This might be based on reporting requirements from a 
funder.

• It might also be based on your logic model – what 
outputs and outcomes you decided were important to 
measure, and questions important to your leadership 
and grantwriting team.

Where to begin?



1. The data set represents a fictious after-school 
homework help program for 6th – 12th graders.

2. After two months of attendance, participants completed 
a satisfaction survey.

3. The program included a special component aimed to 
improve reading for comprehension.  A pre-test and 
post-test was used to measure whether reading 
improved, and these data were added to the dataset. 

4. Participants also brought cans of food for the 
Community Food Bank, and this was recorded. 

Analysis plan for your practice data set



1. What were the demographics of participants who completed 
surveys?

2. What were the numbers and percentages of students who 
selected each satisfaction answer option?

3. Did the responses vary by race, ethnicity, or gender?

4. Did the program serve mostly younger teens, or teens of 
varying ages? What was the average age of participants?

5. Did the program serve those with both good grades and 
those with poor grades?

6. Did student test scores improve from pretest to post-test?

Analysis questions for your practice data set



How to count things and do other calculations in 
Excel
1. How to do formulas in Excel.

• Click in an empty cell – this is where the answer will 
go

• Type the = sign to start the formula. For example, 
=2+2.

• Hit Enter to complete the formula and get the 
answer. 

Numbers and Percentages

Also known as Frequencies

Practice



2. How to do functions in Excel. A function is a pre-
defined formula available in Excel.

• Click in an empty cell – this is where the answer 
will go.

• Click the fx (Insert Function) symbol next to the 
formula bar.

• Select the desired function.

• Select the cell range to be used for the function.

• If applicable, enter other necessary criteria and 
hit Enter.

Numbers and Percentages

Practice



Some common functions in Excel for program analysis.

1. Sum – found in fx list of functions

• There’s also a shortcut for this on the Home tab 
∑ AutoSum

2. Count

3. Countif

4. Countblank

5. Min and Max

6. Average

Numbers and Percentages

Practice



Pivot Tables
A pivot table can be:

• A one-variable data table with numbers (counts)

• A one-variable data table with numbers and/or percents

• A two-variable data table (cross-tabulation)

A Faster Way to Get Frequencies



Were staff helpful when 
you had questions?

Number

Always 57

Most of the time 65

A few times 43

Never 24

Missing data 1

Total 190

Example of a one-variable data table



Example of a two-variable data table

Also known as a Cross-Tab

Were staff helpful when 
you had questions?

Female Male Total

Always 28 29 57

Most of the time 35 30 65

A few times 25 18 43

Never 11 13 24

Missing 1 1

Total 100 90 190



1. Click any cell in your dataset

2. Select the Insert Tab on the ribbon

3. On the Insert tab, click PivotTable. A “Create 
Pivot Table” box will appear. 

4. You don’t need to select a Table/Range 
because you already clicked on a cell in your 
dataset. 

5. New Worksheet – pivot table will be created 
on a newly-inserted worksheet

6. Existing Worksheet – if you check this, click 
on a cell in an empty area of the current 
worksheet where you want the pivot table. 

7. Click OK. 

Creating a Pivot Table



8. The Pivot Table layout will display.  

9. Find the question that you want to use for 
your data table. Drag it into the Rows 
window. Your pivot table will begin to 
form on the left.  

10. To get the counts for each answer option, 
you need to use something in the Values 
window.  Drag Survey# into the Values 
window.  

11. Your table may have numbers that are 
way too large.  

Pivot Table



12. In the Values window, it may say, Sum of 
Survey# instead of Count of Survey#.  

13. Click the dropdown arrow on Sum of 
Survey#.  

14. Select Value Field Settings.  

15. From the pop-up box, select Count, and 
click OK.  Now the numbers in your data 
table will look right.   

Pivot Table

Practice



Arranging Rows in Pivot Table

Excel displays rows in alphabetical order
We want to rows to appear in this order:

Always
Most of the time
A few times
Never

1. Right-click on “Always”
2. From the pop-up menu, hover over 

“Move”
3. Select “Move ‘Always’ to Beginning.”
4. Repeat until you have the right order.



Tip for Doing Multiple Pivot Tables

1. After do your first pivot table, highlight it and click Copy.  

2. Click on an empty area several rows below the pivot table.  On 
the Home tab, click the dropdown arrow under the Paste icon.  

3. Select Paste Values to paste a copy of the first data table. 

4. Click into the first (active) Pivot Table again to display the Field 
List.  In the Field List, uncheck the first question that you used, 
and drag the next question into the rows window. 

5. Copy the second pivot table, and use Paste Values to paste a 
copy, and continue until you have all your tables.  



Add Percentages to Data Tables

• In the column to the right of the numbers, 
type the Excel formula for percent, using 
the cell addresses for the numerator and 
denominator. 

Use a formula to calculate a percentage.  Percent = Row value ÷ Total 

• The formula will display in the formula bar.  
Highlight the cell for the denominator and 
press F4 on your keyboard.  
This will add $ symbols to the cell address –
this tells Excel to keep this cell address as a 
constant.  



Add Percentages to Data Tables

• Your first percent will appear as a decimal.  
On the Home tab click on the % sign to 
convert the decimal to a percent. 

• Hold your cursor over the lower right corner 
of the cell containing the percentage until 
the cursor marker looks like this 

• Drag the cell down and the Excel will auto-
calculate the rest of the percentages in the 
column. 





Valid Percent

• What if you have a data table that looks 
like this. There are a lot of missing data.

• Missing data is unknown – we don’t know 
what they would have answered. 

• When there is this much missing data, it 
reduces the rest of the percentages, which 
makes them misleading. 





Valid Percent

• To compute Valid Percent, subtract 
the missing data from the total to 
create a new denominator.

• In this example, for Valid Percent, 
each row value is divided by 137 
instead of 190. 

• The resulting valid percents give 
more truthful percentages as a 
proportion of those whose answers 
are known. 



Cross Tab Tables

Analysis Plan question: Did the responses vary by race, ethnicity, 
or gender?

1. Create a one-variable pivot table

2. Select a second variable for the cross-tab and drag it into the 
column area.  

For practice:   

• Create a pivot table for Q3-Helpful

• Add a cross-tab by Gender

• Any patterns?  Replace Gender with Race.  Any patterns?



Numeric Data

Calculate Average Age

• Click on an empty cell where the answer will appear.

• Click on fx and from the list of functions, select Average, 
and click OK. 

• In the Functions Arguments box, you need to identify the 
cell range for the calculation.  Click on the first cell for Age. 
Scroll down to the end, hold the shift key, and click the last 
cell – this is a quick way to highlight the column.



• Or you can type the cell range. In 
this example it is H2:H191 



Age Ranges

You can ask Excel to put ages into age ranges.  
There are different methods you might use.  

One Method:  Use a Pivot Table 

• Start a Pivot table and use Age for the rows.

• Right-click on the first age.  

• From the pop-up menu, select Group

• In the Grouping Box, make sure that the 
starting and ending numbers are right. 
Enter an interval number for grouping ages. 



Pre and Post Survey Data

Did you or a member of your grant-writing team write 
measurable objectives about this?  

One Example:  The average reading score of Read4Fun 
participants will increase by at least 15%.

• What analysis would you do to report this?  

Another Example:  At least 60% of Read4Fun participants 
will increase their reading scores by 15 points or more.

• What analysis would you do to report this?



First Example

The average reading score of Read4Fun 

participants will increase by at least 15%. 

• Use the Excel function, “Average” to compute the 
average pretest score for all participants, and the 
repeat this to get the average post-test score. 

• Is the average post-test score higher?  Use a formula 
to calculate the percentage increase. 



Second Example

At least 60% of Read4Fun participants will increase 

their reading scores by 15 points or more.

• Start a new column and label it ChangeScore. 

• Starting with the first participant, create a formula to subtract the 
pretest score from the post-test score. Use cell addresses.   

• Click on the cell with the result, and drag down the rest of the 
column to auto-calculate this formula for everyone.  

• In a blank cell use the “Countif” function to count how many 
ChangeScore values are greater than or equal to 15.  

• Calculate a percent of all participants who had a score of 15 or more. 



Questions?



Thank you!


